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Contacting Support 

IMS Help Desk 
If you are experiencing any difficulty in using this product, you should first review this 
Getting Started manual, the online help (once the application has been installed), and the 
FAQ (Frequently Asked Questions) documents available in the folder under which the MYOB 
IMS Payroll application was installed (C:\Program Files\IMS\IMS Payroll Partner by default). 

Windows itself sometimes causes problems, or makes it appear that another program is 
e problems review the installation documentation in the same 

folder as the FAQ documents. 

MYOB provides a free Help Desk service as part of the annual PSA (Product Support 
Agreement) fee. Support is available via phone, email or online.  

IMS Help Desk  Contact Details 

Hours Open Every day of the year, excluding weekends and statutory (Public) holidays 
8AM  5PM 

Phone 0800 600 110 

E-Mail IMSSupport@myob.com 

Web https://www.myob.com/nz/payroll-software/ims-payroll  

Support via Authorised Dealers 
Selected IMS Dealers have been authorised by IMS to provide local support for IMS Payroll, 
as well as training and installation assistance. If you have agreed with your local dealer to 
use them for support then any subsequent support issues should be directed to them in the 
first instance. 

Note:  rges may apply.  

https://www.myob.com/nz/payroll-software/ims-payroll


 

Quick Start 
If you are an experienced Windows user who understands payroll systems and wants to get 
straight into the program as quickly as possible, follow these steps. 

1. Install the program by clicking on the link contained in the email sent to you and 
following the instructions provided.   

2. Run MYOB IMS Payroll by selecting it from the desktop Icon created. You can also 
select it from the 'Programs' menu. 

3. When the Welcome 
go to the Sample Company.  (If you have already run the program and changed 
companies, this company is in C:\Database Files, assuming the program was installed 
in its default location). 

4. Use the menu entries in the View menu (Company Controls, Employee Information 
or Payroll Processing) to change between the different areas of the program, (or click 
the corresponding toolbar buttons). 

5. Use the tabs just below the toolbar, (in the main area of the window) to change 
between different screens within a program area. 

6. To select different records (including employees), use the Record Selector combo-
box (in the toolbar) to pick a different record from the drop-down list. 

7. To add a new record (including employees), first go to the Standard Tab, and then 
press the New button on the toolbar (or use menu entry 'File | New Record' - Ctrl+N). 

8. To save changes press ENTER (or Ctrl+S), to abandon changes press ESC, and to 
delete records press Ctrl+DEL, or use the corresponding menu entries or toolbar 
buttons. 

9. To process a pay, select the Processing tab, then press the tab for   '1. Open'.  Press 
the Open button at the bottom of the screen, then the Next button to proceed onto 
other screens.  Follow the online help for this and each of the next screens for further 
instructions for each step.  The Active Help option is useful here, make sure the 
Active Help button (at the top right of the toolbar) is down, then the help window 
redisplays every time you select a different screen.  You may wish to move and resize 
these windows so they don't overlap. 

10. To stop the Active Help displaying all the time, click the Active Help button (at the top 
right of the toolbar).  If this button is down, the help window redisplays every time 
you select a different screen.  This command is also available on the Help menu. 

11. Always create a new company to store your real information; don't use the Sample 
Company for this purpose.  From the Welcome Menu select Create a New Company 
and follow the instructions displayed by the 'Create a New Company' wizard. 

  



 

Introduction 

This chapter introduces MYOB IMS Payroll, gives you an idea of what the program can do 
and provides some background to how the system works. 

Overview of MYOB IMS Payroll 

MYOB IMS Payroll 
A simple, yet powerful payroll system to run on latest Windows operating systems . It is a 
tool to help you, and it achieves this by allowing you to record information about employees 
and then effortlessly and automatically calculating their pay. It produces all the necessary 
information for you including banking schedules, tax schedules, management reports and 
costing reports. 

Easy to Use 
The program is designed to be very quick and easy to use, so you can maintain and process 
your payroll without wasting time. 

Multiple Companies 
The program is multi-company so you can process different payrolls held within completely 
separate databases. The program holds each company in a separate Windows folder and 
even includes built-in backup and restore facilities. This allows you to easily manage one or 
many companies, and passwords let you restrict access to sensitive information. 

Flexible 
Using flexible tables you can set up your own rules, calculations and options for processing 
your payroll. Costing codes can be set up to reflect your company, and any number of 
different Payments, Allowances and Deductions can be set up to automatically calculate 
different payments. 

Features 
Highlights of extensive features available in MYOB IMS Payroll: 

• Personal Information, e.g. Name, Address and Job information. 
• Weekly, Fortnightly, Half-Monthly, Four-Weekly, Monthly and non-standard payroll 

cycles and Contractor payments. 
• All NZ Tax codes and calculations. 
• Payroll Giving deductions and associated Tax Credit calculations. 
• KiwiSaver (and Compliant Funds) Employee and Employer contributions, including 

Employer Superannuation Contribution Tax (ESCT) calculations and Total 
Remuneration processing.  

• Electronic Direct Crediting to all major NZ banks (additional banking software may be 
required). 

• Annual Leave and CashUp facility, Service, Alternative, Statutory, Time in Lieu, Shift, 
Parental and Sick leave calculations. 

• Costing Codes, associated Reporting Breaks and Costing reports. 
• Permanent Transactions to reduce data entry each pay period. 



 

• Free format HR Notes and attachments against each employee. 
• Unlimited allowances and deductions, totally under your control. 
• Flexible calculation rules to automate payroll calculations. 
• Pay Points, for report selection by groups. 
• Non-KiwiSaver Compliant Superannuation - Employee and Employer contribution 

calculations. 
• Pay History. 
• Multiple Companies. 
• Logon User security and reporting. 
• Extensive standard reports. 
• Comprehensive and easy to read Payslips. 
• No more tax hassles  create payday files (EI Return and New & Departing EI) and 

KED (KiwiSaver Employment Details)files for Inland Revenue reporting requirements 
(including consolidation of these files where applicable).  

• Ability to import from a Time & Attendance system (additional software required). 
• General Ledger export option to a wide range of export formats. 
• Incredibly easy to use - designed for Microsoft Windows operating systems and 

unlimited help-desk support if required. 
• Regular upgrades - new versions will be sent to you, incorporating any tax or other 

legislative changes. 
• MYOB IMS Payroll provides comprehensive help to assist you in learning quickly, and 

to guide you as you work. 

Online Help 
MYOB IMS Payroll contains extensive online help, just like many other Windows 
applications.  If you have used the help systems in other Windows applications, you should 
be able to use the online help without any difficulty. 

Note:  You can print out the entire online help very easily.  Display the online help, then 
select a section from the Contents and press the Print button.  If you select one of 

 

Within the program there are also many additional help features: 

A Status Bar at the bottom of the window displays a short description of whatever your 
mouse is pointing to, some details about the current employee (e.g. if they are salaried or 
waged), and the current status of the payroll (e.g. if the pay has  
been calculated). 

A Welcome Screen offers some helpful options when the program starts. 

Wizards guide you through complex tasks, e.g. creating a new company. 

Any mandatory or invalid fields are highlighted in red on the screen, so you can see exactly 
where you have to enter or correct information. 

  



 

Active Help 
When you first start using MYOB IMS Payroll, one feature that you will find useful is Active 
Help. This shows the online help, but in addition, it automatically changes to the help topic 
relating to what you are doing in IMS Payroll. This feature makes it incredibly easy to find 
out about the system, and how to use it.  

To turn on or off active help,   
button on the right-hand side of the toolbar.  

If you find that the Help window is hiding some of the main screen, either move it out of the 
way or, resize it so they both fit easily on the screen. (This works best if your desktop area in 
Windows is greater than 1024 x 768 pixels  lookup 'resolution' in your Windows help for 
more details). 

Education Centre 
The MYOB IMS Payroll Education Centre website contains supplemental documentation for 
MYOB IMS Payroll covering a wide range of topics: 

• Release Notes for current and previous releases 
• Documentation for optional MYOB IMS Payroll modules 
• Frequently Asked Questions about various areas of the MYOB IMS Payroll system 
• Specification and template documents providing technical information for import and 

integration functions 

Access the Education Centre at: 

http://help.myob.com/wiki/display/ims/  

http://help.myob.com/wiki/display/ims/


 

Installation 
This chapter provides details on installing and running the program for the first time.  
Additional information is included about the files installed, and on uninstalling the program. 

Installing the Program 
MYOB IMS Payroll is generally provided via an emailed electronic link. To install the software 
on your desktop: 

1. If required log in as an administrator, close any open programmes and make sure 
you are connected to the internet. 

2. Create a folder on your desktop to save the installation into 
3. Click on the link provided in the email to download the software 
4. At the bottom of the screen select the option to Save As and browse through to the 

installation folder you have created to save the file 
5. Browse to the installation folder you have created and double click on the 

downloaded application file to install. Accept the defaults during the installation 
process.  

6. IMS Payroll installs automatically to C:\Program Files(x86)\IMS\IMS 
Payroll Partner 

7. A Sample Company is also provided; this installs to C:\Database Files 
8. In the final step of the installation process select the option to create a Desktop Icon. 

Note:  If you have purchased other IMS add-on modules please install MYOB IMS Payroll 
first. 

Note:  It is recommended that you accept any defaults given by the installation program, 
unless you are sure you know what you are doing. 

Consult with your IT team prior to installing IMS Payroll as they may have different 
requirements for your network.  If you are installing the software on a network, please refer 
to Appendix B (page XX) prior to installation. 

Running the Program 
To start MYOB IMS Payroll click on the Desktop icon and open the Sample Company, open 
a different company or create a new company.  

It is recommended that you open the Sample Company initially and use this as a training 
environment. Here you can learn how to navigate around MYOB 

When the program starts you may see different windows before reaching the main screen.  
Sometimes these screens won't appear, depending on options within the program. 

The Welcome screen gives you various options that allow you to select a company.  Click on 
the button for the option  
you require. 

The User Logon screen requires that you enter a username and password before gaining 
access to a company.  Simply type in your logon details and press ENTER.  If you do not 
know the password, you will not be able to open that company.  (Each company can have 
different users and password with varying levels of access). 



 

The Registration screen will be displayed once you have used the program a few times.  
You must register this program to continue using it.  Registration does not involve any 
additional payment above the purchase cost of the program, it is simply to ensure that your 
company(s) details are registered with IMS so that you can receive product upgrades, 
announcements etc.  Registration is an annual process, so you can expect to see this screen 
once each year for each company you use. 

 

  



 

The MYOB IMS Payroll Window 
This chapter describes the basic appearance of MYOB IMS Payroll, giving you an overview 
of the main window, menus, toolbars and status bar.  If you are not very familiar with other 
Windows programs, you should quickly read this chapter and then work through the 
examples in the next chapter while you are in front of the computer. 

Basic Elements of the IMS Payroll Window 
MYOB IMS Payroll has been designed to run on latest Windows operating systems , and 
uses modern technology and user interface design to make it a very powerful, intuitive and 
easy 
to use system. 

 
The Title Bar appears at the top of the Window, and includes the name of the current 
company. 

The Menu appears just below the title bar. 

The Toolbars appear below the menu bar. 

The different Screens within the program are displayed in the main part of the window, and 
are grouped into three sets  
of tabs - Company Controls, Employee Information and Payroll Processing. (Only one screen 
is displayed at a time). 

The Status Bar appears at the bottom of the window. 

  



 

Title Bar 
The title bar contains the name of the current company you have opened followed by the 
name of this program  MYOB IMS Payroll. The buttons on the right of the title bar allow 
you to minimise, maximise and exit the program, respectively. You can click on the title bar 
to activate the window (if you are currently using another window), or to drag the window 
to a new location. 

Menu 
The menu allows you to perform many activities within the program. Each menu option calls 
up a list of different actions that you can perform. 

Menu Description 

 File The File menu includes commands to create new records and save changes you have made, 
change into a different company, print information to a printer, change printing options and exit. 

 Edit The Edit menu allows you to modify and select information.  It contains commands for cutting, 
copying and pasting information using the Windows clipboard, cancelling changes without saving 
them, finding records and moving to the first, previous, next or last item.  

 View The View menu allows you to change to a different set of screens.  MYOB IMS Payroll is divided into 
three main sets of screens  Company Controls, Employee Information and Payroll Processing.  
Selecting a different set of screens displays the corresponding set of tabs in the main part of the 
window.  There is also an option to show, or hide the Status Bar. 

 Tools The Tools menu contains additional commands, including a Tax Reckoner for calculating gross or 
nett pay, Backup and Restore facilities, the ability to Create a New Company, myIR Options and (if 
set up) General Ledger Export.  If you have purchased and installed optional add-in programs (such 
as the Timeclock Import utility) there may be additional entries on this menu. 

 Help The Help menu allows you to display the Help Window and the About Screen, make or stop the 
Welcome Screen showing when you start the program and turn on or off the Active Help. 

 

  



 

Toolbars 
The toolbars contain buttons that perform many of the most common tasks within the 
program, providing you with a quick  
and easy way to get your work done effectively.  

Main Toolbar 
Contains buttons to perform basic operations: 

 

  

 

1. Create a New Record 

2. Open a Different Company 

3. Save Changes to the Current Rec 

4. Cut, Copy and Paste information to the 
clipboard 

5. Cancel changes without saving 

6. Delete the currently selected record 

7. Change to the Company Controls tabs 

8. Change to the Employee Information 
tabs 

9. Change to the Payroll Processing tabs 

10. Opens the Sundry Reports window 

11. Screen Style 

12. Turn Active Help on or off 

13. Prints the current screen.

 

Selector Toolbar 
Contains a selector and buttons to move to a different record. 

 

1. Select a different record 

2. Find a record 

3. Move to the First record 

4. Move to the Previous record 

5. Move to the Next record 

6. Move to the Last record.

 

  

1 2 3 4 5 6 7 8 9 10 11 12 

1 2 3 4 5 6 
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Payroll Toolbar 
Contains buttons to move to each step in the payroll processing cycle. Pay runs are divided 
into nine steps.   
There is a toolbar button for each, as well as a tick below if that step has been completed. 

 

 

1. Open Period 

2. Enter Timesheets 

3. Check Input 

4. Calculate Pay 

5. Preview Calculation 

6. Print Reports 

7. Bank Pays 

8. Backup Company 

9. Close Period 

Note:  Your Bank Pays icon may appear differently depending on which bank your 
company uses.  When you select a different schedule method on the Company 
Information screen, this icon will change to reflect that bank. 

1 2 3 4 5 6 7 8 9 
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MYOB IMS Payroll Screens 
The main part of the window is divided into a series of screens.  Tabs at the top of 
these screens display the different tabs available, within this area of the program.  By 
clicking on a tab with the mouse, you can move to a different screen. 

There are three areas or sets of screens, within MYOB IMS Payroll. Each has its own 
set of tabs. 

Menu Description 

Company Controls Contains screens to setup payments, deductions, costing codes, pay points, 
and general company details. 

Employee Information Contains screens for standard employee details, payment, leave, KiwiSaver, 
permanent transactions, HR-Notes, totals and historical information. 

Payroll Processing Contains screens to perform each step of the payroll processing cycle, from 
opening a new pay period through to closing the completed pay period. 

Status Bar 
The Status Bar contains helpful information and is divided into three areas:  

 

   

 

1. A status hint that changes to provide a description depending on the location 
of the mouse pointer. 

2. Information about the current employee: 
• Current, Finishing or Terminated. 
• Payroll Frequency (Weekly, Fortnightly, Monthly, etc.). 
• Salary or Wage. 

3. The current payroll status, which is updated whenever you complete a step in 
the payroll processing cycle. 

  

1 2 3 
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A Quick Tour 
This chapter gives you a quick guided tour around the program, introducing you to its 
different features to get you started using the program and discovering its benefits. 

In this chapter you will learn how to use the program - moving around the different 
screens, adding, changing and deleting information and running a pay. 

The examples in this chapter assume you are in front of your computer using the 
program to work through these instructions on the screen.  The examples all use 
information from the Sample Company that is created when you first installed the 
program so, unless you have changed to a different company, you will be in the right 
one.  (If you have changed to a different company, the default location of the Sample 
Company is in C:\Database Files). 

Note:  If you can't find this company, go to the Company Information tab and then 
select the Find command (in the Edit menu).  This will display a Find window 
allowing you to search for companies.  Press the Find Now button and 
double click on the Sample Company icon when it is displayed in the 
window.  This will start another copy of the program, opening the Sample 
Company.  (To get to the Company Information tab in the first place, select 
Company Controls from the View menu, and then click on the tab titled 
Company). 

Using MYOB IMS Payroll you can: 

• Set up Company Controls describing allowances, deductions, costing codes, 
pay points and other company related information that control how your 
employees are paid, how calculations are performed, and where information is 
reported. 

• Record and maintain Employee Information, including details on personal and 
job related information, payment and taxation details, leave entitlements and 
balances, KiwiSaver related information, free-format HR Notes, permanent 
(recurring) transactions, payment totals and detailed earnings history. 

• Perform Payroll Processing to open a new pay period, enter and check 
timesheet transactions, calculate and preview a pay calculation, print reports, 
create banking files, backup the company and finally close off the completed 
pay period. 
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Reviewing Company Controls 
In this section you will look at different information about the company, using tabs to 
display different screens, select, navigate through and find different records. 

To display the Company Controls tabs, click the Company button on the toolbar, or 
select Company Controls from the View menu. 

Note:  You will see that this button stays down, and the other buttons (Employee 
and Payroll) pop up, so the area you are currently in is easy to see. 

Displaying Screens 
Now display the Company Information tab by clicking on the tab labelled Company: 

 
You can now see general details about this company including its name, address, 
banking details and other options. 

If you are using a costing system, ensure that the Costing Required option is selected 
on the Company tab  Company Options, then click on the tab labelled Costing Codes.  
A screen will be displayed that has details about all the costing codes that payments 
can be charged to for accounting purposes, including the current totals.  

An Auditing facility is automatically activated and Employee and Company tab Audit 
reports can be printed via the Sundry Reports menu.  

Selecting Records 

 
The Record Selector in the toolbar displays the code for the costing code you are 
currently displaying.  Click anywhere in this record selector and you will see a drop-
down list appear showing all the available costing codes.  Click on a different name 
and see that the screen now shows the details for that record. 

 
You can also use toolbar buttons to go to the First, Previous, Next or Last costing code 
in this list.  Experiment with these buttons now to see how the information changes. 

Finding Records 
Now click the Find button (      ). This will display a window that lists information related 
to the tab you are in. The Find Record feature has powerful record selection and 
sorting functions see the document Find Record  Grid Help Manual on the MYOB 
IMS Payroll Education Centre for more information. 

You can scroll through this list using the scroll-bars at the right and bottom of this 
window, or by pressing the arrow keys on the keyboard. Notice that the details in the 
main screen are updated when you select a different costing code. To remove this 
window, click the Close button or double-click on the costing code that you want to be 
displayed on the main screen.  
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You can customise the Find window to suit yourself: 

• Rearrange columns by dragging a column heading to a new location.  
• Resize columns by dragging the border between column headings. 
• Resize the window by dragging its sizing corner (at the very bottom right 

corner of the window). 
• Change the window's location by dragging the title bar to move the window. 

These changes are saved so they will always apply when you display this find window 
again. 
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Creating a New Company 
This chapter gives you instructions for creating your own company, loading 
information about your employees, and the ongoing running of pay calculations. 

Note:  If you have a large or complex payroll, be warned that this chapter is not a 
complete implementation plan for installing a large system.  It is 
recommended that you get professional assistance through your dealer or 
from the MYOB IMS Payroll Support team to assist you in setting up your 
payroll system. 

Preparation 
One of the keys to successfully using any payroll system is preparation. Before you 
start setting up a new company, make sure you have the following information 
available: 

• Company details including its Bank Account and IRD number. 
• A list of Departments/Pay Points. 
• A complete list of Allowances and other Payments that can be paid. 
• A complete list of the different types of Deductions made from pays. 
• Personal files (or equivalent) for every employee. 

Note:  Any of these details may be changed or added to at a later date if need be. 

Depending on what information you decide to load into the system, you may also 
need: 

• Current leave entitlements and balances for each employee. 
• Tax and KiwiSaver Year to Date figures for each employee. 
• Leave Earnings History for each employee (see the Leave Earnings History 

document on the MYOBIMS Payroll Education Centre).  
• A complete list of Cost Centres/Costing Codes. 
• Costing YTD totals for every Cost Centre/Costing Code. 
• Current Apprenticeship Hours for all Apprentices. 
• Account Codes from your Accounting System. 

With this information at hand, you will find it much easier to concentrate on the 
important details of setting up your company in MYOB IMS Payroll. 

Multi-Company Setup 
Some organisations will need to set up multiple companies to manage their payroll.  It 
is much easier to set up each company to start with than to blindly put everything into 
one company and have to change things later. Give careful consideration to whether 
you need multiple companies.  Some areas to consider include: - 

Whether some employees are paid in a separate payroll for security purposes. 

Whether you are responsible for different companies, e.g. you are operating a payroll 
bureau service. 
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Whether employees are paid from different bank accounts belonging to different 
divisions or other areas within a company. 

Whether you have different payrolls with the same frequency, e.g. paying some 
fortnightly staff one week and other fortnightly staff on the next week. 

If any of the above apply, you probably need to set up multiple companies.  For 
additional information on managing multiple companies, refer to 'Working with 
Companies' in the online help.  The rest of this chapter assumes you are only going to 
have a single company  (although many steps also apply to a multi-company setup). 

Creating a Company 
To create a new company, select New Company from the Tools menu.  This will 
display the Create a New Company wizard, which will guide you through the required 
steps. 

 
Note:  The IMS Sample Company is automatically stored in a folder called 

, 
e.g. C:\Database Files). This folder will be removed if the program is 
uninstalled. Therefore, this location should not be used when Step 2 of the 
wizard asks you to specify a location for your new payroll company. 

After you have created your new company using this wizard, you can enter details into 
all the tab screens within the Company Controls area. 

Note:  After creating a new company, press F1 to display the Help window, and 
then click the Checklist button.  This will display another Help window giving 
you a quick reference list to all the steps documented here, indexed back to 
the main help window. 

Company Information 
As noted above, the Company Screen is where you begin configuring IMS Payroll to 
suit your needs.  
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The left had side of the screen covers information about your company i.e. name, 
address and company IRD number etc. There is also a place to record your client ID 
with MYOB. 

The contact name, phone numbers and fax numbers are provided to the IRD in your 
pay day file. They use this for contact information so it is important it is kept up to date. 

Beside the IRD number is a Large Employer? tick box. If this is ticked it means that the 
IRD require you to pay them twice a month.     

If you are using IMS Online, the IMS Online section will need to be enabled. If not, this 
section can be ignored. 

The Company Options area is where you can turn various functions on or off. If you 
want a feed to your General Ledger tick this box. If you have Service Leave in your 
company tick this box and so on.  

 
Separate documents are available covering Costings/General Ledger, User Security, 
Payroll Giving, Shift/Service Leave and minimum wage top ups. Please refer to these 
for further information if required. 

Sick Leave and DV Leave in advance should be ticked if you wish any leave taken in 
 

Transaction Dates 1 and 2 as well as Comments give you extra columns when you are 
running your pay. They allow you to record start and end dates for leave and add 
comments to any payments made.  It is recommended these be turned on. 

Pay Day Filing should be ticked if you wish to automatically create your file. There is a 
separate document available covering Payday Filing. 

Ticking the Active box next to Annual Leave in Weeks activates the weekly Annual 
Leave method. 

Note:  This change is irreversible. Once you have activated the weekly method, it 
cannot be deactivated. 

The Annual Leave in Weeks section contains options to set any new Set Hours 
employees to calculate Annual Leave weekly by default, and to update all existing Set 
Hours employees to weekly Annual Leave. It also contains options that affect the 

. 

There is also an option to record a Company Anniversary Date for leave purposes 
available here as well as your company bank account information. 

The final section on the screen is about KiwiSaver. A separate document is available 
covering KiwiSaver. 



19 

Pay Points 
Pay points are used for two purposes: 

• To print payslips in the correct order for easy distribution to different locations. 
• To order and sub-total some reports into a pay point (department) order. 

If these considerations are not important to you, simply create a single pay point (it can 
be named whatever you like). 

Click the New Record button (     ) to create a new pay point.  

Note:  If you are using IMS Online Pay Points are used to control who approves 
leave for the various areas.  

Costing Codes 
If you are not using a costing system, you can ignore this screen.  Go to the Company 
tab and ensure the Costing Required? option is unchecked. This will hide the costing 
code field from the employee and timesheet screens. 

If you are using a costing system, enter all your costing codes here. See the Help topics 
on Costing Codes and General Ledger for details. 

Click the New Record button (     ) to create a new cost code.  

Payments 
IMS Payroll comes with a number of standard payments such as Ordinary Time, Salary 
and all leave types. 

If you need any payments created specific to your company these will need to be set 
up. See the Payments and Deductions document for more information. 

Deductions 
IMS Payroll comes with a number of standard deductions such as PAYE, Child Support 
and Student Loan.  

If you need any deductions created specific to your company these will need to be set 
up. See the Payments and Deductions document for more information. 

General Ledger 
If you do not require a feed to your General ledger system, you can ignore this screen. 
Go to the Company tab and ensure the General Ledger? option is unchecked. 

If you are using General Ledger, enter your codes here. See the Help topics on Costing 
Codes and General Ledger for details. 

User Codes 
If you have ticked User Security on the Company tab, the User Codes tab allows you 
to assign usernames and passwords for each person who you wish to access to the 
payroll.  You can also choose what area of the program each user has access to. 
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administrator can affect the user to change their password after a nominated number 
of days.  

If you run more than one company, each can have their own set of codes. 

See the User Security document for more information. 

Auditing 
Auditing is automatically activated for each payroll company.  

The following tabs under Employee Information are audited: Standard, Payment, 
Annual Leave, KiwiSaver, Permanent, Service Leave, Shift Leave and Super. The 
Sundry Reports > Employee Audit report can be used to print, and optionally delete, 
audited records.  

In addition, the Company, Payments and Deductions tabs under Company Controls 
are also audited. The Sundry Reports > Company Audit report can be used to print, 
and optionally delete, audited records.  
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Employee Information 
In this section you will look at different information about employees, and change, 
delete and add employee information. You will see how to add free-format HR Notes 
to an employee, and how to setup permanent transactions which can dramatically 
reduce the number of timesheet transaction entries you have to enter every pay 
period. 

To display the Employee Information tabs, click the Employee button on the toolbar or 
select Employee Information from the View menu. 

Then click the Standard tab to display basic information about an employee, such as 
their name and address.  

Note:  You must create a company before you can create an employee. 

Adding a New Employee 
To create a new employee, make sure that you are in the Employee area. Navigate to 
the Standard tab then click the New Record button on the toolbar (     ). This starts a 
New Hire wizard that takes you through the first four tabs in the Employee area; 
Standard, Payment, Leave and KiwiSaver.  

Many of the fields will be highlighted, usually with a red background these are the 
fields that you must enter information into.  

Note:  Some fields will automatically change highlighting, depending on other 
options you have set.  

Fill in all the fields on the Standard tab (for this example, use your own name, address, 
etc.). Then click the More> button or go to the Payment tab, complete that screen, and 
then move on to the Leave tab. The last screen to address is the KiwiSaver screen. 

You can only save your new employee when you have filled in the required fields on 
all four screens. (If you don't have a valid Bank Account number, select the Cheque 
payment method instead, and if you don't know a valid IRD number select ND  (No 
Declaration) for the tax code and enter zeroes in the IRD Number field). 

If you want to find out more about an individual field on one of these screens, refer to 
the online help (press F1 if it is not visible). 

When you have finished entering all the information on all four screens, press the 
Enter key or click the Save button (     ). 

Congratulations!  You have just created your first employee. 

Here are some helpful hints when loading new employees: 

• You may find it quicker to complete the first four screens for all your 
employees, then load other information, e.g. permanent transactions later. 

• If you cannot save an employee after entering the information on the first four 
screens, check these screens carefully for any missing or incorrect information.  
Missing or incorrect information will be highlighted with a red background. 

• If an employee has not given a valid IRD number, use the ND  (No Notification) 
tax code, and enter zeroes in the IRD Number field (you cannot enter invalid 
IRD numbers except all zeroes).  



22 

• If an employee has not given a valid bank account number, set up a payment 
method of Cheque for now, and get the correct bank account from the 
employee as soon as possible. 

• Sometimes fields will remain highlighted after you have entered information. 
This will be because the information you have entered is wrong (e.g. bank 
accounts and IRD numbers have check digits built in so the program can work 
out if you have entered a valid number or not).  If this happens, enter the 
correct information.  (The status bar at the bottom of the window will display a 
hint that will explain the error). 

o Bank account numbers only have two digits in the suffix. If you are 
 

o IRD numbers are nine digits long. If you are given an right digit number 
 

• There is no need to click on the Wage or Salary checkboxes.  When you enter a 
Pay Rate or a Salary, the corresponding option will be checked for you. 

• If you are entering Pay Rates 2, 3, 4 or 5, make sure the same rate number is 
used for the same purpose for every employee, e.g. you might use Rate 2 for a 
fixed overtime rate. 

• The Hours Worked Per Day and Per Period figures are important for leave 
calculations when Annual Leave is in Days or Hours. When Annual Leave in 

. If you 
are getting inconsistent leave figures, go back and check these fields. 

• If you are doing a lot of data entry, use Ctrl+N rather than the toolbar button or 
menu entry to add a new employee. 

• Don't load YTD totals yet it is best to leave this task until you have loaded all 
employees. 

• Depending on the options you have set in the Company screen, you may also 
need to enter Service Leave, Shift Leave, and Superannuation details. 

Note:  
employee information - use the Backup/Restore option from the Tools 
menu. 

Changing Information 
Changing information is very easy, just use the Tab key or the mouse to move the 
cursor to the field you want to change and type in the new information (try changing 
an employee's address). When you make a change you will see that the New and 
Delete buttons on the toolbar become disabled, and the Save and Cancel buttons 
become enabled. While you can click the Save button to save these changes, most of 
the time it is easier and quicker to just press the Enter key. 

Try changing the address again, but this time press the Esc key (or the Cancel button) 
instead of saving. You will see that the old address returns and you have lost your 
changes.  This is a very useful key if you accidentally change something or decide not 
to make a change you have started. 

Note:  When you make changes, they are not saved until you press Enter or click 
the Save button. However, if you change to a different tab or exit the 
program, the changes will be saved unless there are errors or missing 
information. This is to avoid losing changes. It is recommended that you get 
into the habit of pressing Enter yourself to save all your changes. 
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Deleting Records 
Select an employee and click the Delete button (      ) on the toolbar this is the same 
as typing Ctrl+Del or selecting Delete Record from the Edit menu.  

A message box will appear, asking you to confirm the deletion. Click the OK button if 
you want to delete the record.  You may see another message box appear: 

 
As you can see, the program checks that it is safe to delete a record before letting you 
do it.  If the record was unused, e.g. if you had just set up a new employee and not 
paid them, this message would not have appeared and the employee would have 
been deleted. 

Free Format HR Notes 
You can store anything you like in the free-format HR Notes area. It is designed for 
entering text, e.g. job descriptions, employee career history, disciplinary warnings, 
details of work related accidents, but using the power of Windows you can include 
other objects, such as spreadsheets, graphs, photos or even video. (The amount of 
information you are able to store is only limited by the amount of disk space you have 
available). 

To enter free-format HR Notes, go to the HR / Notes tab under Employee Information. 
Then right-click the large box in the main window and select You can now 
type in your notes: 

• If you want to format these notes, e.g. change the font or size, use the toolbar 
commands. 

• If you want to add another object (attachment) such as a picture, right-click in 
the Attachments section. 

To get additional help, press F1 for the help menu. This will provide operational 
instructions for the HR Notes facility. 
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Permanent Transactions 
Permanent transactions are simply timesheet entries (e.g. hours, allowances or 
deductions) that are paid to an employee every time that employee is paid. Proper use 
of permanent transactions can dramatically reduce the number of timesheet entries 
you have to key in each pay period. 

Permanent Transactions are generally used for the following: 

• Most Deductions, as they are usually made on a regular basis. 
• Standard hours for a wage worker, e.g. an employee who normally works 40 

hours per week. 
• Standard allowances that are paid every pay, e.g. a laundry or service 

allowance. 
• Each time you open a new pay period, all employees who are included in that 

period will have their old timesheet entries deleted, and new ones created that 
are copied from this permanent transaction screen. 

Note:  IMS Payroll automatically creates some transactions when you open a pay 
period, even if they are not on the permanent screen.  These include PAYE 
tax, KiwiSaver & Compliant Fund deductions (if applicable) and a Salary 
transaction for salaried staff.  If you try to enter one of these transactions 
yourself, you will receive a warning message reminding you that it is 
unnecessary for you to set these up. 

Note:  
example, you could later override the number of hours on a waged 
employee if it was different from what they normally worked.  

Using the Permanent Transaction Screen 
This screen is different from other screens you have seen so far because it allows you 
to enter many different records on the one screen.  You can insert and delete entries 
in a list that can be longer than will fit on the screen.  However, you will find that it is 
very easy to use and is quite similar to the other screens. 
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Use the selector dropdown to choose a different employee. 

Click  to insert a new permanent transaction. 

Click  to delete the currently selected transaction. 

The  icon indicates which transaction is currently selected. 

Note:  This screen can be customised to best suit your timesheet entry preferences. 
Therefore you may find that the columns on your screen are in a different 
order to what is shown here. Refer to the online help if you want to 
customise this screen. 

Adding Transactions 
When you first go to this screen you will be able to immediately enter a new 
transaction. To create a new Health Insurance deduction, start typing in the name. As 
you type each letter you will see that the first payment or deduction that matches your 
typing so far will be displayed. Keep typing until the correct name is displayed.  You 
will find that you usually only need to type two or three letters. Then press Tab to 
move to the Quantity field and type 1. 

Next, press the Enter key to add this transaction and you will see that it is inserted into 
the correct place in the list and you can now immediately enter another transaction. 

Now try adding a second bank account to an employee's permanent transactions.  
This time click on the drop down arrow to the right of the Payment or Deduction 
column as this allows you to pick an item from a list. Choose Bank Deduction  from 
the list. 
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After you have selected the deduction notice that the Quantity field has 1 in it. This is 
because most deductions are made once a period, so this just saves you a bit of 
typing. Enter an amount into the Rate field (you can see it is highlighted, to tell you 
that a rate is required). Then press Enter and you will see this window: 

 
This allows you to enter the additional details that are required for this deduction to be 
made.  The bank account is the employee's account number that this deduction is 
going to, and the other fields will appear on their bank statement. Press Enter (or click 
OK) when you have entered a bank account and reference. (You cannot enter 
anything into the Balance field for this deduction, because it is not set up as a 
Reducing Balance type deduction). Refer to the Payments and Deductions document 
for more information about setting up deductions. 

Deleting Transactions 
To delete a permanent transaction, use the arrow keys or mouse to select the entry 
you want to delete - try deleting the Health Insurance deduction you just added.  Then 
click the Delete button on the toolbar (or type Ctrl+Del), and click OK on the window 
that appears, that asks if you are sure you want to delete this record. 

  



27 

Changing Transactions 
To change a permanent transaction just use the arrow keys or mouse to select the 
item that you want to change and type in the new details. Remember to press Enter 
when you have finished. 

Try changing a costing code (use the drop down list for either the costing code or the 
costing description as you probably don't know the costing codes in this company).  
Notice that the code and description are now displayed in italics.  This indicates that 
you have done a costing code override. Similarly, if you override a rate it will be 
displayed in italics. 

Note:  Everything you have learnt here also applies to entering timesheets, which 
you will get to soon, as both screens are very similar.  

Setting Up Other Information 

information required before checking your payroll. 

Loading Employee YTD Totals 
If you are starting part way through a tax year, you may wish to load employees' YTD 
earnings figures.  You will also need to add any employees who have left your 
company since the start of the tax year.  When you enter a termination date for an 
employee, special transactions are created (such as to pay out remaining holiday pay).  
Since these employees have already terminated, simply delete their transactions from 
the first payroll process you run. 

To load YTD totals, go to the Totals tab in the Employee Information area and select 
the Accumulators tab. Select an employee and click the  button. A 
window will appear where you can enter the YTD totals, click the Add button, then the 
Close button. 

Note:  This adds to the existing figures rather than replacing them. Therefore, if you 
make an error you must call up this window and enter the difference, rather 
than the correct figure. 

Loading KiwiSaver YTD Figures 
If you are starting part way through a tax year, you may wish to load employees  YTD 
earnings figures.   

To load YTD totals, go to the KiwiSaver tab (in the Employee Information area). Select 
an employee and press the  button. A window will appear where you 
can enter the YTD totals, press the Add button, then the Close button. 

Note:  This adds to the existing figures rather than replacing them. Therefore, if you 
make an error you must call up this window and enter the difference, rather 
than the correct figure. 

Note:  The KiwiSaver year may run from either April or July (as set on the Company 
Tab). Please confirm this before loading totals. 
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Loading Cash Rounding and Apprentice Hours 
These totals can also be maintained using the Load Totals window described in the 
previous paragraph. 

Loading Superannuation, Service Leave and Shift Leave 
If you have chosen any of these options on the Company screen, make sure you load 
Year to Date figures and balances under their respective sections on each employee.  
There is a full description of these tabs in the online help. 

Loading Employee Leave Balances 
These can be loaded using the Leave screen (in the Employee Information area). The 
online help has descriptions of each of the fields on this screen. 

When Annual Leave in Weeks is enabled in the Company Settings, you can tick 
Calculate Annual Leave in Weeks to activate weekly Annual Leave for an employee. 
Under weekly Annual leave, 
weeks, and the fields in the Agreed Definition of a Week section are used to calculate 

y balances and entitlements. These fields represent what 
is agreed as constituting a working week for the employee. 

Note:  The Reports tab (in the Payroll Processing area) contains several leave 
reports that will be helpful in double checking the information you have 
entered. 

You have now almost finished setting up your company. However, before checking 
everything, there are some other useful things to set up: standard reports and 
customised screen layouts.  

Loading Employee Leave Earnings History 
This information is required by the Holiday Act 2003. The information, once loaded, 

 Leave Earnings tab. See the document 
Leave Earnings History document on the MYOB IMS Payroll Education Centre for 
more information. This document outlines what information is required and methods 
by which to load it, including a Bulk Load process using a standard CSV file. 

Loading Costing Totals 
If you are using the built-in costing features, you can load existing YTD costing totals 
into the system.  You only need to do this if you are starting part way through a year, 
and you want the totals on the costing reports produced by MYOB IMS Payroll to 
include these old figures. 

To load these totals, go to the Costing Code tab (in the Company Controls area) and 

to the costing totals where you can enter your existing figures.  

Note that this adds to the existing figures rather than replacing them.  Therefore, if you 
make an error you must call up this window and enter the difference, rather than the 
correct figure. 
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Setting up Standard Reports 
The Reports tab (in the Payroll Processing area) allows you to set up a list of standard 
reports that can be printed with a single click of a button each pay period.  It is 
recommended that you print off or preview a copy of each report listed here on your 
first pay run.  While doing this you can also review all of the report options for each 
report, which are displayed when you click the Options button. 

Decide which reports and options are important to you and which ones you want 
printed each pay period.  You can add a report to the list of standard reports by 
clicking on it and clicking the Add>> button. Then use the arrow buttons at the right-
hand side of the screen to adjust the order of this report within the list.  Remember to 
set up the options now, as these are saved and used each time you print the report. 

Note:  A report can be added several times to the Standard Reports list.  This is very 
useful if you want one report printed off using different options, as each 
copy of the report has its own set of options saved. 

The Company Summary, Employee Payroll Summary and Trial Balance reports are key 
reports for checking a pay calculation, and you will almost certainly want to print at 
least one of these.  The Cash, Cheque, Bank and Deduction schedules are usually 
printed too (unless you have, for example, no cash pays). 

Of course, Payslips are invariably printed and there are many options available for this 
report to let you customise the information that appears here.  Note that if you need to 
change paper on your printer before printing payslips it is best to leave this report off 
the Standard Reports list and print them separately. 

Customising Screen Layouts 
The Find windows and the Permanent and Timesheet entry screens can be 
customised to suit your needs.  

To customise the Find window, go to a screen, e.g. the Employee Standard tab, and 
press the Find button in the toolbar (or Ctrl+F). Columns in the grid that is displayed 
can be moved and resized. To move a column to a new location, drag the column 
heading itself. To resize a column, drag the right-hand border of the column heading; 
the mouse pointer will change when you move the mouse over the right spot. Each 
Find window, e.g. Find Employees, Find Allowances, Find Costing Codes etc., can be 
customised separately.  You can also resize and move the entire window so it appears 
at a convenient location on the screen, each time that you open it. 

The Permanent and Timesheet entry screen columns can be customised in the same 
way as the Find window. For example, since deductions are often the only entries that 
are on the Permanent transaction screen you may find it best to display the Payment 
or Deduction column first on this screen. On the timesheet entry screen, it may be 
better to have the Quantity column first. 

If you have many timesheet entries to key in each pay period, you may find that 
customising the timesheet entry screen saves you a reasonable amount of time every 
time you process a pay. 
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Processing Pays 

Parallel Pay Calculations 
This section discusses how to run a pay. However, before you run a real pay it is 
important to perform a parallel run, to check that everything is loaded correctly. 

A parallel run involves running the details of an actual pay on both your existing 
system (whether it is computer or manual based) and on MYOB IMS Payroll, and 
comparing the results. Any differences between the two sets of results must be 
investigated and corrected. 

Note:  Do a backup before starting your parallel pay run, and restore afterwards, as 
 the results of this pay kept. 

The following information should be checked: 

• Payslips. 
• Reports. 
• Costing Totals. 
• Leave Balances. 
• Gross Pay. 
• Tax. 
• Net Pay. 
• Banking interface (you may even wish to send a trial file to the bank using your 

banking software.  If you do, make sure the bank is informed so they don't 
process the file as a real pay). 

Once you have successfully completed your parallel pay run, congratulations, MYOB 
IMS Payroll is ready to go! 

 

To display the Payroll Processing tabs, click the Processing button on the toolbar, or 
select Payroll Processing from the View menu. 

Processing a complete Pay is very easy with MYOB IMS Payroll. There is a simple 
series of steps to go through, each one on a separate tab in the Payroll Processing 
area. The program guides you through each step, making sure you don't make any 
mistakes or forget something. This will give you confidence that you (or whoever is 
processing the pays) will do a complete and accurate job every time. 

Note:  If you find that you cannot complete one of these steps because the button 
you are trying to click doesn't do anything, you have probably missed one of 
the earlier steps in the cycle. Ticks underneath the Payroll toolbar show you 
the stage the payroll is up to. Use the <Back button to find the step that you 
have missed or select it from the Payroll toolbar and carry on from there. 
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Step 1  Open Period 
Go to the tab labelled '1-Open' in the Payroll Processing area.  The Sample Company is 
set up with defaults to open a period including just the weekly employees in this 
company.  Press the Open button near the bottom of the window and wait for the 
Open Per
timesheet.  

Step 1  Open Period holds three dates. It is important that each is recorded correctly: 

• Reporting Date: this is used in financial transactions and usually aligns with the 
Period End Date; 

• Period End Date: this is the end of the pay period you are currently paying for; 
• Employee Payment Date: this is the date your employees received their pay. It 

is used in all reporting to the IRD. 

If you look at the Status bar at the bottom of the window, you will see a Progress bar 
indicating how far through the program has got opening the period.  When this is 
finished, you will see ticks appear under the Open Period and Enter Timesheets 
buttons on the toolbar, and the Payroll Status (at very bottom right of the window) will 
change to Entered . These are convenient ways to let you know exactly how far 
through the payroll cycle you are. 

 

About Pay Periods 
Every time you want to calculate a pay you must Open a new pay period and 
complete all the steps described below through to Closing the pay period again.  
When you open a period, you are selecting a group of employees who will be 
included in this pay run, e.g. all your weekly and fortnightly staff. Then you can add, 
alter or delete those employees' timesheet transactions, to reflect what you wish to 
pay in this period, and then proceed onto the subsequent steps. 
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Once you have opened a period you cannot pay other employees who are not 
included in that period; however, you can stop employees who are in this period from 
being paid by deleting all their timesheet entries. (You can also open a period as a 
non-standard pay that allows you to pay any individual employees on an ad-hoc 
basis). 

You can now click the Next button, which will take you to the next tab screen: 2. 
Timesheets. 

Note:  In the future, before you open your pay period, you will need to consider 

there are no boxes are ticked. For example, at the start of each tax period, 
you would reset the tax accumulator, by placing a tick in its box. These are 
located to the right of the Open Period screen. Also make sure that any 
required reports which report on Tax period accumulations have been 
printed prior to resetting, such as the Payment schedule and Trial Balance (if 
required). 

Step 2  Enter Timesheets 
This screen is where all timesheet entries are displayed and maintained. It works in the 
same way as the Permanent tab under Employee Information see page 24. 

On this screen you will typically enter any hours worked, leave taken and allowances 
claimed. You can also enter individual payslip messages that will print on an 
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For now, simply enter a few transactions, such as Ordinary Time and Time and a Half 
for a few employees. There are many other transactions you can enter on this screen 
including: 

• splitting hours across multiple costing codes. 
• overriding pay rates. 
• overriding costing codes. 
• one-off adjustments to permanent transactions. 
• one-off deductions. 
• using a daily rate with a Salary transaction (possibly with a negative quantity). 

Refer to the online help if you require any additional information on these features. 

Days Paid For 

 
Standard: 
Hours Worked per Day, as seen on their Payment tab. (If Annual Leave in Weeks is 
enabled, these fields are read-
Definition of a Week; if not, you can edit them directly.)  

Holiday Rate: 
units, i.e. ordinary hours, leave and holiday transactions (excludes overtime). If Annual 
Leave in Weeks is not enabled, these days will be used in the calculation of Holiday 
Average and Ordinary daily rates.  

Note:  For quick access to this field use Ctrl/+. 

Average Daily Pay (ADP): Reflects the total number of whole and part days worked ie: 
ordinary days worked plus any additional days. Ie If an employee normally works 5 
days ordinary time (Monday  Friday) and a half day overtime on Saturday then the 
Holiday Rate days would need to be 5 and the Average Daily Pay days 6. These days 
will be used in the calculation of the Average Daily Pay rate where required in paying 
Sick, Bereavement, Statutory Holiday and Alternative leave where it is unclear what the 
employee would have earned on that day had they worked.  

Both Days Paid For fields should be as accurate as possible and may be overwritten. 
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Relative Hours 

 
Relative Hours: These hours are required to be entered for any leave and holiday 
transactions for employees with Permanent, Variable Hours or Set Hours employment, 

 

This is required due to irregular hours per day these employees may work during the 
pay period.  

Totals 

 
Total Hours:  

Days Paid for, Relative Hours and Total Hours should reflect as accurately as possible 
what units the employee worked in the pay period. This is required as the calculation 
of Leave and Holiday rates may require this information to be accurate (depending on 

recorded in). 

When you have finished entering timesheets, click the Next button to move to the next 
tab screen. 

Step 3  Check Timesheet Entry 
Click the Check button to display the Pay Point Batch Control Listing in this window.  
This is very useful if you calculate batch control totals for your timesheets before you 
start keying them in, as it can provide an excellent double check that all your 
timesheets have been entered correctly.  

If you want to find out more about this feature, press F1 to display the Help window 
and click on the entry About the Pay Point Batch Control Listing. 

For now, just click the Next button to move to the Calculate Pay screen after 
producing this listing. 

Note:  The Delete Unpaid button on this screen may be useful to you.  It will delete 
all transactions for any unpaid employees (Unpaid employees may have 

or any other payments).  This can speed up the pay calculation and ensure 
those employees do not receive a payslip. 
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Step 4  Calculate Pay 
Actually calculating the pay couldn't be easier, just click the Calculate button then sit 
back and wait for the program to calculate everything for you!. 

Then click the Next button to move to the Preview screen. 

Note:  You can re-calculate a pay whenever you like, and as many times as you like.  
If, after previewing the pay calculation or printing reports, you find a mistake 
just correct it.  The Payroll Status will change back to Entered and you can 
then go back to Step 3.  Check Input and carry on from there. (Note:  After 
you have closed the period - Step 9, you can no longer do re-calculations).  

Step 5  Preview Calculation 
The preview screen displays a summary of each employee's pay. Have a look at a few 
employees' pay to familiarise yourself with this screen. When you are done press the 
Previewed button, and then click the Next button to move to the next tab screen. 

 
Note:  Although you could use the Preview Calculation option to check each 

individual employee, this would probably take too long unless you have a 
small payroll. Rather you will probably just check those employees you are 
particularly interested in for some reason. For example, someone may have 
an uncommon allowance payment or you may want to double-check 
something you weren't 100% sure about when doing your timesheet entry. 
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Step 6  Print Reports 
This screen allows you to set up a list of standard reports that you print each period.  
Then each pay period, you can simply press the Print List and wait for them all to print.  

However, in this section we will look in a bit more detail at some of the options 
available on this screen. 

 
Note:  Other areas where you can print reports are: 

Sundry Reports: Available from the File menu and Toolbar. This gives you listings of 
employees, transactions, payments and deductions, Leave Rates etc. 

General Ledger Export: Available from the Tools menu. (This will only appear if you 
have General Ledger? ticked on the Company screen.) 

IRD Reporting Available from the Tools menu. Employee Information return file for 
payday filing, KED KiwiSaver Employment Details file, IR Reconciliation Report and 
Digital File Consolidation.  
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Previewing a Report on Screen 
Click on the Company Summary entry in the All Payroll Reports box, and then click the 
Preview button. After a short delay  
(a progress bar will be displayed in a pop-up window), the report will be displayed in 
the print preview window:  

 
In this window you can move to different tabs, resize the window, zoom in and out, 
save the report in different formats, e.g. PDF or Text and print the report. Refer to the 
online help (press F1 in this window if it is not showing) if you need any assistance with 
any of these commands. 

Changing Report Options 
Many report titles are displayed in bold in the list boxes. These reports have additional 
options. Click on the Employee Payroll Summary report and then click the Options 
button. This window will be displayed:  
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Select the full report option (it may already be selected), click the Close button and 
print this report (to screen or printer).   
Then display this options window again, select the Summary Only option and print the 
report again to compare the results. 

Many reports have options to control their sort order, print ranges and sometimes, 
additional options.  You may like to spend some time now experimenting with these 
different options.  At least have a look at the payslip options, as there are many 
variations available for you to customise your payslips. 

Note:  The report options are saved when you change them, so the next time you 
print a report the same options are used.  Therefore, leave the reports on the 
options you find most useful. 

If you want to find out now about setting up a list of standard reports to print each pay 
period, you can use the online help.  Press F1 to display the Help window and click on 
the entry Setting-Up a List of Standard Reports. 

When you have finished looking at reports, click the Print List button (remember that 
you have to complete each step  even if there are no reports in your list) and then 
click the Next button to move to the next tab screen. 

Note:  Some reports have the option to save as a CSV format. This will allow you to 
export the data and open in excel. Watch for the Data File Extract option 
towards the bottom of these reports. 

 

Step 7  Bank Pays 
MYOB IMS Payroll can create a file that you can import to your online banking system. 
The format required in selected on the Company tab. 

Enter the Banking Due Date (i.e. that you want your employees to receive their pay). 
Click on the Options Button to navigate to the folder where you want to save your file. 
Change the name of the file itself if you wish to save historical bank files. 

You can then click on Create File and the file will be available to upload to your bank. 

Note:  If you have chosen to print your bank schedule on the Company tab Step 7 
 Bank Pays will be skipped. 

If you want to find out now how to set up the banking interface correctly, press F1 to 
display the Help window and click on the entry Setting up an Electronic Banking 
Interface. 

The actual process of sending this file to your bank varies between the different 
programs you can use, and this isn't a real pay to send to the bank. Therefore for now, 
(after creating the file) move straight onto the next step. 

Click the Next button to move to the next tab screen. 

Note:  If you do not wish to use Banking software may go onto the next step 
without doing anything on this screen. 
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Step 8  Backup Company 
Note:  It is very important that your companies are backed-up after every pay.  In 

the unlikely event that you have a serious problem with your pay, you must 
be able to recover your payroll information, and still produce the next pay on 
time. This is why the program includes a built-in backup routine. 

Identify the directory where you wish to copy your back-ups to. It is recommended 
that a separate back-up folder be created. Once this is identified initially, MYOB IMS 
Payroll will remember it. 

It is recommended that you tick and accept the option to append the date to the back-
up file name. This will ensure you can select the correct version should you need to re-
install it. 

 
Note:  Read the online help about backing-up your data. Press F1 to display the 

Help window and click on the entry About Backups and Restores. 

Note:  It is important that the contents of your PC are backed-up to a secure 
alternative site (i.e. another PC or disk). This will ensure that you are able to 
run the pay should your PC become corrupted or damaged. 

Now click the Next button to move to the final Payroll Process tab. 
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Step 9  Close Period 
This is the final step in processing the pay.  After this step you will no longer be able to 
re-calculate the pay.  You will have to wait until the next period or run a special, one-
off, non-standard pay run if you want to make any pay changes.  Therefore, as it says 
on the screen, do not click on the Close button unless you know that the payroll 
calculation is correct. 

 
To close this pay period, click the Close button now, and wait for the program to finish 
this task. When you close a pay period, the following happens: 

• All employees in this period have their totals updated. 
• All cost centres have their totals updated. 

Congratulations! You have now successfully paid these employees and finished a 
complete payroll processing cycle. 

Note:  If you have selected the option to automatically create IRD payday files you 
closed screen will look different. See the Payday Filing documentation for 
more information. 

Ongoing Payroll Processing 
Now that the system is fully operational, there are a few details that you should be 
aware of to ensure it keeps running smoothly.  As you have seen, the system is very 
easy to use, and these points will help make sure everything continues to operate well. 

Note:  The most important point is to keep regular backups.  If you have a problem 
you can always restore to a known 'good' backup and correctly redo the 
work done since then.  

Processing Sequence 
Before opening a pay period, you should do any employee maintenance (and 
company control maintenance, if any).  This is particularly important for permanent 
transactions as these transactions are copied to the timesheet when the period is 
opened. 

Before closing a pay period, check all you reports etc, as any mistakes or omissions are 
much easier to correct when a pay period is still open. 
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Pay Adjustments and Corrections 
Sometimes you will find an error (e.g. some overtime missed off a timesheet) that has 
to be fixed and paid now, even though the pay period is closed.  Staff leaving or even 
one-off bonuses may also require immediate action, outside the normal payroll 
processing cycle.  In these cases you can open a Non-Standard period - just check that 
option on the Open Period tab. 

A Non-Standard pay calculation is processed just like any other, except only the 
transactions you enter are paid - the permanent transactions are not copied over, and 
salaries are not automatically paid.  This allows you to adjust individual employees in 
any way you like. 

For not so urgent payroll adjustments, you can simply include the appropriate 
transactions the next time you process a pay for that employee - this is the easiest way 
and should be used whenever possible. 

Overpayments 
If you have overpaid an employee, you can adjust their information by entering 
negative quantities - this will correct YTD figures etc. Realise that if a recovery results in 
an employee getting a take home pay less than zero (rather than just reducing their 
pay), you will still have to recover that amount. This can be done through a deduction 
to recover a fixed amount in subsequent pays, unless they repay or return the money. 
This deduction should be a reducing balance deduction, so it will automatically stop 
when the overpayment has been fully recovered. 

Paying More Than One Period 
In some situations, such as when an employee is going on leave for several weeks and 
wishes to be paid in advance, or when your company closes down over Christmas and 
employees are paid for the close down period in advance, you may want to pay more 
than a single pay period in a pay calculation. 

We recommend against this, as it may produce incorrect data for payday filing and 
can result in an incorrect Average Weekly Earnings rate (AWE) for Holiday Pay. 

If you do proceed with paying multiple pays in one period, note that the employee 
may be taxed too much. To prevent this, IMS Payroll must be told that several pay s 
periods are being calculated. To do this and ensure the correct tax is calculated, simply 
change the Quantity on the PAYE timesheet transaction for each employee to contain 
the number of pay periods to pay. 

For example, a fortnightly paid employee is going on leave for 4 weeks, and wants 
their pay in advance, i.e. their 2 weeks they would normally be paid, and an extra 2 
weeks. Enter 20 days (or 160 hours) annual leave. Then change their PAYE quantity to 

 

Note:  When changing the PAYE quantity a message dialogue screen is displayed 
advising you to check the quantity  of all other Payments and Deductions 
pertaining to this employee. For Student Loan Repayments (including SLBOR 
and SLCIR) and Child Support type deductions the QUANTITY should also be 
the same as the PAYE quantity. KiwiSaver deductions based on a percentage 
must retain the quantity of 1.  

  



42 

IRD Reporting 
The IRD requires a file to be sent to them each pay period. This will generally be one 
file called the Employee Information File. If you have someone starting or finishing a 
second file will be created called the New & Departing File. For further information, 
read the Payday Filing document. 

Payday Filing 
To produce an EI Return and/or New & Departing EI file for payday filing, choose IRD 
Reporting from the Tools Menu. Select EI  Payday Filing Report/File and the 
following screen will be displayed: 

 
1. Select the pay to report on from the table at the top of the window. 
2. Tick the boxes for the files you want to create: 

o The Employee_Details file, which contains details of any employees 
who started or ended their employment during the selected the pay 
period. 

o The EI Return file, which contains pay amounts and details for each 
employee in the selected pay. 

3. Tick the Print Report boxes if you want to produce a printed version of the 
selected file(s) for review or your own records. 

4. If you use an intermediary, e.g. a tax agency who files on your behalf, enter 
their IRD number. 

5. If you are producing a printed EI return file, tick Print EI Return Totals Only? to 
display only totals for the pay in the printed report. 
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6. Click Print and Create File(s) to generate the files and/or reports. 
7. If you have elected to create return file(s), you should then use Inland 

Revenue  

KiwiSaver Employment Details (KED) 

 
and the following screen will be displayed: 

 
1. Select the month you want to include in the report / file. 
2. If you want to create an electronic version, make sure Create KED myIR File? is 

selected. Type or use the Browse button to change the location of the folder 
you want to save the file to. 

3. Click either Preview or Print and Create File (depending on the options 
selected) to produce the report/file.  

4. If you have chosen to create a f  
website to transfer it to them. 

Note:  The current pay will not be included, unless the period is closed. 

Digital File Consolidation (EI Return KED) 
When several payroll companies use the same IRD number and they have the same 
Employee Payment Date for a pay run the Digital File Consolidation process can be 
used.  

To combine the files, choose Digital File Consolidation from the IRD Reporting 
window and select the Consolidation Type you want to perform. 

1. Click the Browse button to select the files you wish to consolidate. 
2. Click Add to List. 
3. Repeat this until all digital files for this company are listed in the box. 
4. Type or click Browse to select an output filename. The import files will be 

combined and saved into this file. 
5. Click Create File to consolidate the digital Files. 

If you need to remove a digital File from the imports list, click on it and press Remove 
from List. Click Remove All to clear all entries from the list. 

myIR website to transfer it to them. 

Note:  Consolidation is not required for payday filing as the IRD can now accept 
multiple files with the same date. 
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General Ledger Export 
If you have chosen to use a general ledger system with MYOB IMS Payroll and set up 
the required general ledger account codes, the General Ledger transactions will be 
completed when you close a pay run. 

 required. 

 
Note:  The current pay will not be included unless the period is closed. 

For further information, refer to the Costings and General Ledger document. 

End of Period 
When you are ready to open the first pay in a new period, you must indicate if you are 
starting a new costing, deduction or tax period. You can do this by setting the 
appropriate Period option(s) in the Reset Accumulators panel on the 1-Open tab. 

MYOB IMS Payroll will determine these settings for you according to the default 
Employee Payment Date displayed on the 1-Open tab for each pay period. If you 
change the Employee Payment Date before opening a pay period, you should ensure 
that the appropriate option(s) are set in the Reset Accumulators panel on the Open 
Period tab. Under normal circumstances, period accumulators should be reset when 
you open the first pay period in a new tax, costing or deduction period. 

Note:  You must double check that these have been checked correctly before 
closing the pay period, otherwise your reports will be affected. 

When running the last pay for the month, you should print off the appropriate reports, 
e.g. Deduction Schedules if you send these off monthly and any other costing or leave 
reports that you review monthly. 
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Appendix  Network Installation 
MYOB IMS Payroll can operate over a network, i.e. multi-user.  

The Application should be installed locally on each workstation which will be utilised to 
process the payroll. 

The Company (database files) can reside on a network drive. 

Note:  Ensure that the permissions on the folder containing the Company (database 
files) are set to Full Control for the user operating the payroll system. 

Note:  For more advanced networking requirements using Terminal Services, RDP 
or similar technologies, see the Installation Options document.  


